Visual COBOL for Visual Studio Getting Started with Solutions, Projects and the

1)

COBOL CALL Statement

Overview

1.

Solutions and Projects

In Visual COBOL for Visual Studio, the main unit of work is called a solution. Solutions can contain multiple
projects. These projects can be managed code COBOL projects or native code COBOL projects or can be
C# projects or VB.NET projects, etc. Visual COBOL projects can contain only COBOL programs or classes
but these programs and classes can interact with the programs or classes contained within projects
written in a different language like C#.

There are two basic types of projects, Application projects and Library projects. Normally, a solution
would contain a main Application project like a Windows Forms Application, WPF Application or a Console
Application. Application projects generate an output file with the .EXE extension and contain the main
entry point of an application. Library projects, like a Class Library or a Link Library typically contain
programs and classes that are called by the main application project. Library projects generate an output
file with the .DLL extension.

Each project can contain one or more source programs or class programs. In managed code, each project
is compiled into a single output file called an assembly. In native code COBOL Application and Library
projects you can also select to have multiple output files. In this case, each individual program within the
project will be compiled into its own .EXE or .DLL.

Problems with Calling Programs Located in Different Projects

Each project specifies an output folder into which its generated output files will be stored. The default
name of this folder varies depending on the project CPU settings and which build type you are using such
as DEBUG or RELEASE. The default location is in a subfolder which is relative to the projects main folder,
i.e., .\bin\x86\debug. This default name of the output folder is configurable under the COBOL tab of the
Project Properties page.

There are two issues that need to be addressed when a program in one project calls a program in another
project.

1. Programs that are called cannot be found.

When an application is started in Visual Studio the output folder in which the main application resides will
become the current folder. Programs that are called must either be placed in this startup folder or all
programs must be placed in a different folder or they must reside in a folder that is locatable via
environment variable PATH.

2. Entry points that are called that are different from the name of the .DLL cannot be found.

When the name of the program in the call statement matches the name of the .DLL on disk then it will be
found as long as the conditions in 1 above are true. But if calling an entry point which is the name of
another program within the .DLL or the name of an entry point specified in an ENTRY statement within a
program in the .DLL, the .DLL containing the program to be called must be preloaded in order to make its
entry points visible to the run-time system. This can be done using one of the following methods.

- set proc-pointer to entry “dliname”

- Micro Focus Entry Name Mapper (MFENTMAP)

- Interop Preload section of app.config file (managed code only)

All of these scenarios will be covered in the tutorials that follow.
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Working with Managed Code calling Native Code (P/Invoke)

The .NET Framework provides for several techniques and classes that allow managed code to interact with
native code and vice versa. These techniques and classes are known as Interop classes.

In this tutorial you will be shown how to setup and use a Visual COBOL solution containing a managed code
main application project and a native code Link Library project containing a program that will be called. The
technology that allows native code programs to be called from managed code is called Platform Invoke or
P/Invoke for short.

Visual COBOL does a lot of work under the covers to make this somewhat complicated technology seem quite
simple. Most COBOL data types can be freely passed between managed code and native with the exception of
pointer data items that are embedded in a group.

Start Visual COBOL and from the main menu select New > Project as shown below:
F Start Page - Microso
File | Edit View Debug Team Data Tools Test Window Help

Project... Ctrl+ShiftsN | |

New * |iEd
Open * | '@ WebSite... Shift+Alt=N |5
Close Lig Team Project...
Close Solution ] File.. Ctri+N
s  SaveSelected ltems Ctrl+S Project From Existing Code...

F
On the New Project Dialog select Managed under COBOL, highlight Console Application and then change the
Project Name and Location to managedpinvoke and C:\managedpinvoke respectively. Also uncheck the option
for Create Directory for Solution so that your project will have the same folder structure as shown in this
tutorial. Click OK to create the new project.
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Visual COBOL will automatically create a solution with the same name as your project file and will add a new
Program1.cbl file to the project. If you do not see the Solution Explorer Window or the Properties Window you
can select to display them under the View menu item.

00 managedpimvoke - Micozoft Visual Studio = — 3 = 1@5@“
e it View Bropct Buld Debug Team Date Tooks Tegt Wiedow Help

fadr T A - = L1101 P (Debug. | Any CPU “| [\ | overwrite -if<h
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Programl.cbl [Code] = Schation Explorer v X
-l N R
prograv-id. Programl as “smsnagedpinvoke.Programl™. A Solution ‘managedpinvoke’ (1 pro
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do(n-di-:::wn. ) & Properties
working-storage section. d References
procedure division. ) Prageamd cbi

goback,

end progras drogrand,

Programl bl Comgile ltemn Properti »

o

4

Y v o
100 % Bulld Actieny  Compile

When using P/Invoke, the CPU types must match between the managed calling program and the called native
program. In this example we will create a 32-bit native program so we must change the CPU type of the
managed project from anyCPU to x86.

Start the Configuration Manager by right clicking on the Solution name in Solution Explorer, (first item) and
selecting Configuration Manager from the list.
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Open up the drop down list underneath the Platform heading and select <New...>

r 2
Cmﬁgumﬁo,_ [N

Active solution configuration: Active solution platform:
[Debug v] [Any CPU VJ
Project contexts (check the project configurations to build or deploy):
Project Configuration Platform Build
managedpinvoke Debug B iAny CPU E
Ani CPU
<Edit..>

Select x86 from the list so it looks like below and then click on OK.

> !
New Project Platform -9 (|

New platform:

s g
Copy settings from:

| Any CPU -

[] Create new solution platforms

[ ok || cance |

Open the drop down list underneath Active solution platform and select <New...>

e ~——p)|
cMﬁgumﬁor_ M

Active solution configuration: Active solution platform:

[Debug v] |An¥CPU vl

Project contexts (check the project configurations to build or dep A GRS
Project Configuration <Edit...>

I managedpinvoke Debug B %86 [Z] ‘

Select x86 from the list so it looks like below and then click on OK.

.
New Solution Platform 1=

Type or select the new platform:

b@6| v
Copy settings from:
| Any CPU ~|

[] Create new project platforms

[ ok || cance |
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The Configuration Manager dialog should now look like below:
Click Close to finish.

Configuration Manager .‘_ ) a— ‘ @lﬂ

Active solution configuration: Active solution platform:
[Debug '] ["85 vJ
Project contexts (check the project configurations to build or deploy):
Project Configuration Platform Build
managedpinvoke Debug [Z] x86 [Z] ¥

e |

Modify the source code to Program1.cbl in the editor so that it looks exactly like the image below:

program-id. Programl as “managedpinvoke.Programl”. + ; Sclution 'managedpiny

4 g‘ﬂ managedpinvoke
data division.
working-storage section.
@1 custRecord.
@5 contact pic x(2@).
@5 company pic x(28).

=d| Properties
»  |«3] References
@_ Programl.chl

@5 phone pic x(15).
procedure division.
try

call "program2” using custRecord
catch ex as type Exception
display ex::Message
goback
end-try
display "contact " contact
display “company " company
display "phone " phone
goback.

4|
£ Soluti...

B Team...
Properties
COBOL File Properties

=

w

Notice that there is a blue squiggle underneath custRecord in the call statement. This is Intellisense in action.
If you position the mouse over this squiggle you will see an error message because there currently no program
named “program?2” exists in the solution. This can be ignored.

Page 5



Visual COBOL for Visual Studio Getting Started with Solutions, Projects and the

COBOL CALL Statement

Now we will add a native project to our Solution.

Right click on the Solution name in the Solution Explorer window and then Select Add > New Project as shown
below. Make sure that you right click on the Solution name which will be at the top and not the Project name

which will be under it.

[Code]* »

[F}

~| =% procedure division

program-id. Programl as “managedpinvoke.Proeraml™.

data division.
working-storage section.
@1 custRecord.

Build Solution
Rebuild Selution

Clean Solution

85 contact pic »(28). Batch Build...
85 company pic »(28). o )
85 phone pic x(15). Configuration Manager...
procedure division. Add
try =
call "program2” using custRecord Set StartUp Projects...
catch ex as type Exception .:C:im Project Details Window

Solution Explorer *1x
- i
£ B [ Snlutinn 'managedpinvoke’ (1 proje
Ctrl+Shift+B edpinvoke
roperties
eferences
rograml.chbl
\ Mew Project...
Existing Project...
MNew Web Site...

Select Native under COBOL and then Link Library as the project type. Change the name of the project to
programl and leave the Location set to c:\managedpinvoke so that the new project will be in a subfolder of
the main solution. Click Add to add the new project to the solution as shown below:

Test Progects
Qther Progect Types

Online Templates

program2

c\managedpinvcke

Recent Templates NET Framewoek 4 - )mw Defai .
Installed Templates pr——
| ra
| Windows Applicat
4 COBOL f_ indows Application
Databaze
Managed v ‘l Conscle Application
m —
Web cm | Empty Project
Visual Basic —
Visual Co |28 | Link Lbsrary
Visual Co e ikl \
" Liary
Visual Fe g Micte Fmvrmvwv’
Database

Type: COBOL

COBOL
A nutive project for creating classes usable
by other applications

COBOL

COBOL

CoBOL

COBOL

The new project program2 will be created and the default program Program1.cbl will be added to it.
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For this example we need to rename the new program1.cbl file in project program2 to be program2.cbl. Right
click on Program1.cbl under project program2 and select Rename.

Salution Explorer -3 X
oD

identificetion division 4 Schuticn ‘managedpinvcke’ 2 prop
progran-id. Prograsl - | « ¥ managedpinvoke

W Properties
envirconment division, 4 Reterences

i
onfiguration sectiar

%y, Programl cbi

date divisio n s 5 prugrand

working-storage section ’ W Properties
ol Neferancen
vcedure dlvision R i
J Open
goback > Open With
end progrem Progreml 7 satus 9 Cornpile

Exchite From Progect

Progeam] .ol Create Project
bl |} | A Cat Cirte X
» \d Copy CirleC
Buld Act X Dete [
Copy To Renarme
oy | Debug IS AETESE 1 Custom Reset wource deectives

Custom

Change the name from Program1.cbl to program2.cbl ensuring that you add the .cbl extension so that it will
be recognized as a COBOL program. The new Solution should look like the following:

L0 R Programl.chl [Code]™ Ll Solution Explorer v 1 X
. | NEEE
identification division. == ; Solution 'managedpinvoke’ (2 projg
program-id. Programl. + § 4 (=] managedpinvoke
. L =d| Properties
en\-rlch-nmen'lc d1v151?n. . [l References
configuration section.
@ Programl.chl

4[] program?
=d| Properties
+g] References
procedure division. [m| program2.chl

data division.
working-storage section.

goback.

4 | [ | 3

end program Programl. I-'-’f‘g Soluti... E?if Team... BB Class...
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Edit program2.cbl so that it looks like below. Make sure that you change the program-id from Program1 to
“prog2” and then delete the end program statement at the bottom. The $Sset case directive is also necessary.

fset case
identification division.
program-id. “prog2”.
environment divisicon.
configuration section.
data divisicon.
working-storage section.
linkage secticn.
81 custRecord.
85 contact pic x(2@).
85 company pic =(2@).
@5 phone pic =(15}.
procedure division using custRecord.

move "John Smith" to contact
move "Micro Focus™ to company
move "888-632-6265" to phone
goback.

Now press F11 to build the project and start debugging. When the call statement is executed the catch code
will be executed to handle the exception. Hover the mouse over the ex variable and you will see the contents
of the exception message. If you have the Autos window opened you will also see it displayed there.

Programl.chl [Code] ¢

I%Programl 'I ¥ oex o
= program-id. Programl as "managedpinvoke.Programl”. +
data division.
= working-storage section.
@1 custRecord. =
@5 contact pic x(2@).
@5 company pic x(2@).
@5 phone pic x(15).
= procedure division.
try
call "program2” using custRecord
catch ex as type Exception
=2 Hisplay ex::Message
goback “2 ex|{"173  Called program file not found in drive/directory [program2]"} = |
end-try
display "contact " contact T
100% - 4 L4
MName Value Type =
& CUSTRECORD {Length = 55}: " GROUP
“ig EX {"173  Called program file r System.E

The message is the same error that we saw in the previous tutorials; Runtime Error 173. The Run-time System
error 173 means that the name in the program name referenced in the call statement could not be found.
Continue to press F11 to step through the rest of program1 until it ends.

Change the name in the call statement from program2 to prog2 and debug again by pressing F11. The same
error occurs. So what is the problem?
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The problem is that program?2 is in a different project which has a different output folder than the calling
project.

managedpinvoke.exe is in C:\managedpinvoke\managedpinvoke\bin\x86\Debug

and

program2.dll is in C:\managedpinvoke\program2\bin\x86\Debug

When the application is started the folder containing the startup program becomes the current folder so any
programs that it calls, such as program2.dll must either also be in the startup folder or they must be in a folder
which is referenced in the PATH environment variable.

When using P/Invoke with a managed code main program you cannot add a reference to the program?2 project
like you can if calling between two managed projects because it will not be able to load the native assembly.

You can however, add a reference to the managed project that points directly to the native .dll.

In Solution Explorer, right click on the References folder under the managedpinvoke project and select
Add.Reference.

Programl.cbl [Code] X Solution Explorer * 0 x
=
~| “¥ procedure division m NN
program-id. Programl as “"managedpinvoke.Programl”. == ; Selution 'managedpinvoke’ (2 projy

4 (=] managedpinvoke
data division. =d| Properties

working-storage section.

» |51 Ref;
@1 custRecord. @: Pre Add Reference...
85 contact pic x(28). 3 =
85 company pic x(28). b Ej program2 .
85 phone pic x(15). =d| Properties
procedure division. g References
try [ml proaram2.chl

On the Add Reference Dialog, click the Browse tab and then navigate to
c:\managedpinvoke\program2\bin\x86\debug and select program2.dll and click Add OK.

oo Add Reference _ M
| NET [ COM | Projects| Browse |Recent|

Look in: Debug < ¥ £ [
Name 2 Date medified Type
i % program2.dil 8/28/20121:27 PM  Application exter
< . = »
File name: program2.dll -

' Files of type: [Component Files {".dll:" tlb;" olb;" ocx;™ exe) 'J

0K ] ‘ Cancel ]
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Highlight program2.dll in the references list and change its Copy Local property to True. This will cause
program2.dll to be copied into the output folder of the managedpinvoke project when it is built.

Programi «pl [Code) =

-| ¥ procedure division . g

program-10 r os “managedpinvoke. Prograsl” W Propertes
o o Neferances
fata division

working-storage section,

J Yystem

A System.Core
"l
2 System XmlLling
" ytact pic x(20) F » z
W Data Data’
04 par pic x(20) 2 Sytem Data DataSet!
0% phane plec x(1%). J Syvtem Dt
cedure division A System iml
try a progam’d
call “program2” using custie | o Programl ol
atch At type t m .
iisplay iNessage e It '
oendg-try s )
display “contact tact operties &
display "company Compan program? Reference Properties
alsplay “phane * phor o Wl
goback '

T e [

o | Debug . ; " v R l'} _
Stepplng over non-usar code "MicroFocus . COROL ., Progrea.Plnnec . Fin False
pnce exception of type 'System. DilNotloundtxception' occurred in managedpldnwv
Stepping over non-user code 'System, Typelosdixceoption . Messago.get’
n [B056) managedpinvoke . exe! Managed (vA. 0. 30319)7 has exdted with cooe 0 (f
Copy local

" ' Indhc ates whettior the reference will be

cnniad bo the s lec wdnd dossto

Press F11 to rebuild and start debugging again. Notice that the squiggle underneath custRecord in the call
statement now disappears because the program is found at compile time. Keep pressing F11 to step into
program2 and then back into program1 until finished. Notice that the debugger did not step through the
source code of the native program. That is a restriction of Visual COBOL. You can debug either managed code
or native code in the same solution but you cannot debug them at the same time. We will cover debugging the
native code program at the end of this tutorial.

Change the call statement to reference “prog2” instead of “program?2” and then step through again. The call
statement can reference either the program-id name or the program name on disk and both are resolved by
adding a reference.

Although, adding a project reference is the easiest way to resolve program names when calling between
projects the other methods demonstrated in the previous tutorials will also work with P/Invoke. You may want
to use one of the following methods if you have a large number of projects or if you wish to call programs in
assemblies that are not part of the current solution.

Let’s reset the project to try the other methods. Open the References folder under the managedpinvoke
project. Right click on program2 in the References list and select Remove to remove the reference.
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Using Windows Explorer, navigate to the folder c:\managedpinvoke\managedpinvoke\bin\x86\debug and
delete the file program2.dll.

.. « Local Disk (C:) » managedpinvoke » managedpinvoke » bin » x86 » Debug v |4y

—— — ——— ——
Jrganize ¥ [ Open with... Burn New folder
A
i Eavorite: Name Date modified Type Size
Bl Desktop [="] managedpinvoke.exe 8/28/2012 215PM  Application
& Downloads || managedpinvoke.managedpinvoke_Prog... 8/28/2012215PM DY File

8/28/2012 215 PM
8/28/2012 2:NA DM Annlication evtens

%+ Dropbox 2] managedpinvoke.pdb Program Debug D...

“_f.ﬂ Recent Places ] %! program2.dll

Scan for Viruses... T
-4 Libraries Open with...
5| Documents @ WinZip »
J’ Music Restore previous versions
[E=| Pictures ity .
i Videos
Cut
& Computer Copy
& Local BEKIG) Create shortcut
#3 DVD RW Drive (D:) X1 o
4 FreeAgent GoFlex Driv
Rename

Change the name in the call statement of program1.cbl from “prog2” to “program2”.

Right click on the project name managedpinvoke in Solution Explorer and select Add->New Item as shown
below:

progran-id. Trograml 8 sacagedpimvete Frogresl'.

dota divisiem
wOring stacage section,
183 centiecord

0 comtact pic =(28)
o5 compan pic sldW)
5 phoss pic w(1%)

procedure 2ivision,
try

- . 2 4 Nrw e L 4
tall “progl® wming vstlenerd
COTEn wn a4 type fa S A bomeg Rem. a3 Petence
:::f:, ex1iMessage o New Felde &ds arivn Eeteanie
ond-try Aad Lgpevy COBCK Rewws
displey “comtt * ntoct u.ww
diplay “company * .,
display “phose * prove ’ 2
gooach . H u J.j J 204 Sohmen 40 Sowce Comamd.
® 4 P Detadh Window
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Select Application Configuration file from the list and accept the default name of App.config by clicking on

Add.

Online Templates

App.config

e e

P

| Search Ins

Installed Templates Sort by: | Default
4 COBOL Items
Managed % Cursor File

Icon File

Installer Class

Page (WPF)

stalled Templates

Pl

COBOL Items

settings
COBOL Items

COBOL Items

COBOL Items

User Control (WPF) COBOL tems

WCF Service

Window (WPF) COBOL Items

XML File

Application Configuration File COBOL Items

Assembly Resource File COBOL Items

Settings File

COBOL Items

COBOL Items

COBOL Items

Type: COBOL Items

A file used to configure Application

The file will be added to the managedpinvoke project and loaded into the editor. Close the XML version of this

file by clicking on the X in the tab next to app.config name. Then right click on App.config in Solution Explorer

and select Edit.

m Programl.cbl [Code] X

Solution Explorer

'l ¥ procedure division

=

program-id. Programl as "managedpinvoke.Programl”.

data division.
working-storage section.
@1 custRecord.
@5 contact pic x(20).
@5 company pic x(20).

@5 phone pic x(15).
procedure division.
try

call "prog2" using custRecord
catch ex as type Exception
display ex::Message
goback
end-try
display "contact " contact
display "company " company
display "phone " phone

S

\‘fiiﬁ‘

=d| Properties
g References
7] App;

L] Prcg
&0 progran
=d| Prop
3| Refe|

[ prog

MicroFocus.COl
@z IR

g Solution ‘'managedpinvoke' (2 proj
4 % managedpinvoke

Open

Open With...

Edit

Exclude From Project
Cut

Copy
Delete

Rename

Properties

Ctrl+X
Ctrl+C
Del

Alt+Enter
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In the popup editor that appears add the value PATH in the name field and enter the location where the
program?2.dll resides followed by “;%PATH% in the VALUE field and press SET. Then Press OK to save this. The
;%PATH% portion tells it append the current setting of PATH to the new one.

r = :

u-l Application Settings @
Environment ICOBOL Switches

Varable  Value

PATH c:\managedpinvoke\proaram 2\bin \x86 \debug; % ...

Name PATH l
Value c¢:\managedpinvoke'\program2'\bin'x86\debug; “PATH%

| set || Delete |

'[ OK || Cancel

Press F11 to start debugging again and when you execute the call “program2” statement it will now work,
although the squiggle error under custRecord in the call statement remains because the call is being treated as

dynamic, i.e. resolved at run-time instead of compile time.

Stop debugging and change the name in the call statement from program2 to prog2 which is the program-id of
the program to be called. Now press F11 to step through the call statement again. It fails when trying to call

prog2. - .

e L

igraml v| ¥ ex
program-id. Programl as “managedpinvoke.Programl®.

data division.
working-storage section.
@1 custRecord.
85 contact pic x(28).
85 company pic x(28).

85 phane pic x(15).
procedure division.
try

call "prog2" using custRecord
catch ex as type Excepticn

display ex::Message

goback | “¢ ex|{"173  Called program file not found in drive/directory [prog2]"} = |
end-try
display "contact " contact

- 4 *

€ Value Type
' CUSTRECORD {Length = 55}: " GROUP
} EX {"173  Called pregram file r System.E
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The reason that it worked when calling “program2” is that program?2 is also the name of the .dll file on disk,
program?2.dil. When the call statement is executed the run-time system first checks to see if an entry point
named “program2” has already been loaded. If it has then it will call that one. If it hasn’t been loaded, then it
next tries to find a program with that name on disk in the current folder. If that search fails it will search
through the folders specified in PATH, looking for a program called “program2”. In the case of this tutorial
“program2.dll” will be found and loaded and then “program2” will be called.

The reason why it failed when calling “prog2” instead of “program2” is that there is no program called
prog2.dll available on disk.

In this case where you wish to call an entry point of a program that resides within a .dll that has a name other

than the name of the .dll itself then the .dll must be preloaded in order for the call statement to find the entry
point. This is true when calling by program name of by the program-id name if they differ. This also applies to

programs that have multiple entry points by using the COBOL ENTRY statement. Of course, if you have already
called the main entry point of the .dll, in this case “program2” then the .dIl will already be loaded and its entry
points made available.

There are a couple of methods that can be used to preload a .dll whose main entry point has not yet been
called when working with P/Invoke.

First is by setting a procedure-pointer variable to the entry of the .dll name.
Add a variable called pp to the working-storage section of program1.cbl and then add the set statement as

show below before the existing call statement.
program-id. Programl as “managedpinvoke.Programl”. ==

data division.
working-storage section.
@1 custRecord.

@5 contact pic =(28).

@85 company pic =(28).
85 phone pic =(15).
a1 pp procedure-pointer.

procedure division.

set pp to entry "program2”

try

catch ex as type Exception
display ex::Message
goback

end-try

display "contact " contact

display "company " company

displav "phone ™ phone

-

The set statement will preload “program2.dll” and make any entry points in it visible to the COBOL run-time
system. Remember that this will only work if the PATH in the app.config file includes the folder where
program?2.dll resides.

Press F11 to start debugging and step through the call statement to show that it now works correctly.
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The second method to preload a .dll is to use the Micro Focus Entry Point Mapper or MFENTMAP. This is more

complicated to configure than simply using a procedure-pointer but we will include it here for the sake of
completeness.

First, comment out the set statement in our current program by placing an asterisk in column 7 of its source
line as shown below so that the program2.dll will not be preloaded.

program-id. Programl as "managedpinvoke.Programl”. =
data divisien. N
working-storage section.
@l custRecord.
85 contact pic =(2@). =
@5 company pic x(2@).
@5 phone pic ®(15).
@l pp procedure-pointer.
procedure divisicon. =
N set pp to entry “program2™
try
call "prog2" using custRecord
catch ex as type Excepticn
display ex::Message
goback
end-try
display "contact " contact
display “company " company
disolav "phone " phone N

Open up Notepad or any text editor and create a file containing the following three lines:
[ENTRY-POINT] prog2

[PROGRAM-NAME] *

[SUBPROGRAM-NAME] program?2

Save this file in your managedpinvoke project folder using the name “mfentmap.dat”.
If using Notepad, ensure you change the file type to All Files so that it will not add the extension .txt to the file.
So the file will be called C:\managedpinvoke\managedpinvoke\mfentmap.dat.

r -y
/| Save As -
‘@Uv| 7imanagedpinvoke » managedpinvoke » v I s | { Search monagedpinvake ol
Organize v New folder RSP0 4 @
# Dropbox > Name : Date modified Type
=] Recent Places . ez
bin 8/28/201210:25 AM  File folder
e o obj File folder
4 Libraries !
— Properties File folder
<| Documents . it
A % 7] App.config CONFIG File
Jr Music = . i o
y @ managedpinvoke.cblproj COBOL Proj
k=| Pictures iz
e |_| managedpinvoke.dep DEP File
E Videos & 4
Q managedpinvoke.sin Microsoft Vi
- B managedpinvoke.suo Visual Studid
1M Computer 4
B £ || Programl.chl CBL File
fsew Local Disk (C:)
#2) DVD RW Drive (D
- 4 m | 3
File name: mfentmap.dat =
Save as type: | All Files (%) v]
4 Hide Folders Encoding: | ANSI VI [ Save ] [ Cancel ‘
n
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When using MFENTMAP you would create the three entries shown in the file for each of the entry points that
you would like to make known to the run-time system.

[ENTRY-POINT] prog2 - This is the name of the entry point used in the call statement.
[PROGRAM-NAME] * - This is the name of the calling program. Use * to mean any program.
[SUBPROGRAM-NAME] program2 - This is the name of the program that contains the entry point.

In our case when calling “prog2” the run-time system will first load “program2” if required in order to find
“prog2”. To complete the setup we must set the environment variable ENTRYNAMEMAP to point to the
location of the mfentmap.dat file.

Right click on the app.config file in Solution Explorer and select Edit.

Add the new environment variable ENTRYNAMEMAP with the value of the mfentmap.dat file that we saved
previously. Press Set and then OK to Save it.

-l Application Settings lﬁ

‘ Environment | COBOL Switches |

Variable Value
PATH c:\managedpinvoke\progra...

Name ENTRYNAMEMAP

Value c:‘\managedpinvoke‘\managedpinvoke\mfentmap.dat

[ Set ][ Delete

@[ OK || Cancel |

Start debugging by pressing F11 and step through the call statement. “prog2” will now be found via
mfentmap.dat.

If you have a large number of native Link Library projects in your solution it may become a hassle to have to
set the PATH to include the output folders of every project. In this case it may be advantageous to change the
output folders of all projects to point to a common location such as the output folder of the main application
or a new common folder. You must remember that when doing so you must change the output folder for each
build type as these specify different locations.

Let’s give this a try.

First right click on the app.config file under Solution Explorer and select Delete to remove it from the project.
Uncomment the set pp to entry “program?2” statement in program1.cbl so that it will again be executed.
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In Solution Explorer double-click on Properties under the managedpinvoke project heading to display the
Properties page below. Click on the COBOL tab to the left and scroll down until you see the entry for Output
Path.

Change the current value to ..\compiledprogs\bin\x86\debug. This will place the project output into folder
c:\managedpinvoke\compiledprogs\bin\x86\debug. It is best to use the relative paths like “..\” instead of

hardcoding the names in case the solution is moved to another folder.

Click on the save icon to save the changes.

managedpinvoke® > EalGll el Pla RI6T Programl.chbl [Code]* ~ Solution Explorer

Application _g Solution ‘managedpinvaol
LConfiguration: ’Actlve (Debug) vl a @ managedpinvoke
5qL =d| Properties
Platform: [ Active (86) - = Trop
gl References
Copybock Paths B}, Programd.cbl
(L] \_U”IFJIIEIU[ UEUUBBIIIB Dounu cy
Mamespaces & ] ‘E@ program?2 -
Errors and warnings =d| Properties
COBOL . d] References
Warning level: | Include warnings (Level W) v] [8 program2.chl
Debu -
< Stop after: 100 [] Treat warnings as errors 3
Rescurces
Output
Settings Output path: Acompiledprogs\bin'x@6\debug| Bn
[7] Generate directives file [7] Generate listing file
‘ 1 - r

Close the managedpinvoke property page and open up the property page for the program2 project and make
the same changes that you made to managedpinvoke using the same Output Folder name of
..\compiledprogs\bin\x86\debug

Save this and start debugging again by pressing F11 and “program2.dIl” will be loaded by the run-time without
the need for the PATH to be set because “program2.dil” now resides in the same folder as the startup program
managedpinvoke.exe.

Debugging the native code portion of the application.
In order to debug the native programs we must make a couple changes to the project settings.

Open up the properties page for the program2 project by double clicking on Properties underneath the
program?2 project heading in Solution Explorer.
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Select the Debug tab and under Start Actions select the option for Start External Program as shown below:

[IGLICTO Rl program2.chbl [Code]

Application

sQL

Copybook Paths
COBOL

COBOL Link

Debug

Programl.chl [Code]

Configuration: | Active (Debug)

-

Start Action
() Start project

@ Start external program:

() Start browser with URL:

() Wait for debuggable attachment:

Start Options

Command line arguments:

Platform:

Active (xB6)

Wait for directory

»

m

Solutien Explorer

&) &

; Solution ‘managedpinvol
4 (2] managedpinvoke

=d| Properties

> [+3] References

g, Programl.chl
4 (@] program2

=d| Properties

3] References

[m program2.chl

< | n

EETT I Team... B2

Properties

Click on the ellipsis (...) to the right of the Start external program field so that we can select the program to
start when we begin debugging. This will be the managed code program managedpinvoke.exe that calls the

native program.

Navigate to c:\managedpinvoke\managedpinvoke\bin\x86\debug, select managedpinvoke.exe and click Open.

m

Application
Configuration: [Active (Debug) Platform: [Active(x86) VI
SQL :
tart Acti =
Copybook Paths Sttt fiction
(©) Start project
COBOL 2
@ Start external program: E]
COBOL Link | SN i
| oo Select file ﬂ
Debug — . — .
- @uvl « bin » x86 » Debug v [ 43 |[ Search Debug ol
Organize v New folder =~ 0 @
Bl Desktop -~ Name ‘ Date modified Ty
& Downloads 5 =
anagedpinvoke.exe 8/28/2012 2:56 PM -
4+ Dropbox e —  —  —
. Recent Places
~a Libraries l
Show outpd| | Documents
& Music w
Creas =| Pictures
E Videos
1M Computer v @ I b
File name: managedpinvoke.exe v [Executables (*.exg;™ dIL int;*.gr v}
[ Open Iv] [ Cancel J

Click on the Visual Studio save icon to save the change and close the property page.
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Now we must change the Startup project so that we can debug the native program.
Right click on the program2 project heading in Solution Explorer and select Set as Startup Project.

SChuann Eagiores

- 2 ¥
+] 5 Sohution menagedpewnie (0
- o [ musagetgineche

¥ Propecta

o fdteence:

S Frogamd
i
=3 Buie Sropetes
Frtals Frern

R grogreml ot

Frop Depanders e

cord Prgect Baid Orde !
N B
e .
Lot avioce Fetoence
cono Proset Prigmetan
Add Brsting COBOL Bews
Set o1 Stantlip Progect F

Tt .
prooreml <bin

Press F11 to start debugging. The managed code program managedpinvoke.exe will now be run at full speed
and the debugger will appear on the first statement in the procedure division of the native program program?2.
To change back to debugging the managed portion simply change the Startup project back to
managedpinvoke.

(DM Programl.chl [Code]

- | % procedure division

data division.
working-storage section.
linkage section.
81 custRecord.
85 contact pic x(2@).
a5 company pic x(2@).
@5 phone pic x(15).
procedure division using custRecord.

hove "John smith” to contact
move "Micre Focus" to company
move “88@-632-6265" to phone
goback.
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1) Summary

We have covered a number of different scenarios here in the preceding tutorials, some of which may or may
not be applicable to your particular application.

The chart below summarizes the techniques that we covered in these pages and outlines under which
scenarios each can be used.
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